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- Please follow the safety instructions closely to reduce the risk of acci-
dents or damage to equipment.

- Safety instructions are divided into Warning and Attention:
- Keep this manual in an easily accessible place.
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Safety tips

Keep this product away
from heat. 

Note that MP3 player
may malfunction in an
electrostatic environ-
ment.

Warnings

Do not drop an object
or give shock on the
product.

Cautions

Don’t listen to music
for a long time. It may
damage your hearing.

Do not place MP3 play-
er near a magnet or
within the magnetic
field.

Do not operate the
product near water,
dust, or soot.

Do not use this product
while driving.

Back up important data.
(Note that the manufac-
turer is not responsible
for the loss of major
data caused by your
mistake.)



* Precautions in using the touch screen
�� Use the touch screen with clean and dry hands.  
�� Do not press the touch screen hard to make it work. 
�� Touch the point that you want to work in order to operate the 

function correctly. 
�� Be careful not to have any conductive material such as metallic

object on the touch screen. It can cause malfunctions. 
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Name of each component

1

2

3

6

5

4

1 Microphone hole/
RESET button 

2 Record (REC) button

3 Earphone jack

4 USB port

5 LCD (*Touch screen)

6 • Power on/off 

switch ( )
• Hold switch ( )



* Minimum system requirements
- CD-ROM Drive
- Pentium Ι ΙΙ or higher level CPU / 

128MB or larger memory
- 300MB or larger hard disc space, 

800 X 600 mode
- Hi-color (16 bit) or higher level 

video card, Sound card.

Insert the software installation
CD into the CD-ROM.

LG Media Center

1 Select the LG Media Center.

2 Follow the displayed instructions.

- During installation of the LG
Media Center, you can install the
Windows Media Player and the
Internet Explorer for the operating
environment.

3 After finishing the installation,
click [Finish].

4 Click [Start] k [All Programs] k
[LG Media Center] k [LG Media
Center] to start the program.

Installation of the Adobe
Acrobat Reader

1 Select [Adobe Acrobat Reader].
2 Follow the displayed instruction.

View the manual

Select [Manual].

Note
- You must install the Adobe Acrobat

Reader to read the manual.
- We recommand to install the sup-

ported video and audio codecs.
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Installing software
Check the specifications of your PC before using the Player.



AC adapter (Charging time: 3
hours)
Charge the MP3 player with the
supplied AC adapter.
- An AC adapter may not be sup-

plied depending on the models.
- Contact with one of call centers

supplied with this quick setup
guide to buy an AC adapter.

1 Connect the AC adapter to the
AC outlet.

2 Connect the USB cable of AC
adapter to the USB port of MP3
player.

USB cable (Charging time :
More than 4 hours)

MP3 player will be also automatical-
ly charged when connecting the PC
and MP3 player with USB cable.

Note
- Use the supplied AC adapter when

you charge the MP3 player, otherwise
the MP3 player may malfunction.

- Do not charge MP3 player for longer
than 12 hours. Overcharge and
overdischarge may shorten the bat-
tery life.

- If you transfer files on charging, the
charging time will be extended.

- Charge the battery in a place with a
normal temperature.

- After checking  the state of a remain-
ing battery of note book, connect the
USB cable and charge it.

- Do not charge it when the remaining
battery of the note book is not
enough.

- If you transfer files on charging, the
charging time will be extended.

- Charge the battery in a place with
a normal temperature.
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Charging the MP3 player



To Turn on/off the power
Push the power on/off switch in the

direction of the until MP3 player
is turned on.
Push the power on/off switch in the

direction of the until MP3 player
is turned off.

Lock feature
This feature locks MP3 player to
prevent it from operating when
you accidentally press a button.

1 Push the power on/off switch in

the direction of the to lock MP3
player.

- Upon locked status, will be
displayed on the LCD. 

Upon pressing of each button, 
will appear for two seconds and
disappear.

2 Push the power on/off switch in

the opposite direction of the 
button to unlock the device.

Reset feature
This feature is to reset the player
when the MP3 player does not 
operate normally.

1 Prick the hole with a sharp object
when the MP3 player does not
operate normally.

2 After the power is turned off, push
the power on/off  switch in the

direction of the . Then, the
power will be turned on.
- When MP3 player is connected to

PC with USB cable, it will be auto-
matically turned on.

- Reset function initializes setting
values.

Locked

Locked
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Basic operation



You can operate various features by using the Home menu.

* Home menu screen varies according to product models (FM radio recep-
tion is optional.)

1 Music : Moves to the music mode.
2 Movie : Moves to the video mode.
3 Photo : Moves to the image mode.
4 Radio : Receives and records FM broadcasting.

(FM radio reception is optional.)
5 Text : Moves to the text mode.
6 All Files : Displays the playable total list.
7 Game : Moves to the game mode.
8 Settings : Sets the operating environment of the player.
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Home menu screen
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1 Turn the MP3 player on.
- The home menu appears on LCD.

2 Press the icon of a desired menu.

3 Press the icon of selected menu.

4 Press the desired menu to move
to the second level and then
press the selected menu to 
execute the menu.

Note
- Press to return to the 

previous menu during operation.

- Press and move to the right
downward direction to return to the
home menu during operation.

- Press and move to the left
upward direction to return to the pre-
vious menu in the home menu.
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General operations of Home menu

Icon of the selected menu

Contents of the selected menu
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Playing music
You can use the functions of MP3 player by touching the LCD.

Press the middle part of LCD during playback.
Press the middle part of LCD again to resume
playback.

Drag the middle part of LCD in the direction of 
the left/right  during playback. 

Drag the LCD during playback and then press 
and hold the LCD. And then release at a point 
you want.

Keep pressing and turn the point you press on 
LCD clockwise/counterclockwise during playback.

Play/Pause Skip/Search Volume control

24

: Pause, : Play

/ : Skip

/ : Search

Volume control

Note

- Select a file you want and press , you can delete it.
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Playing music

A-B

+

-

You can use the functions of MP3 player by touching the control box on
LCD.

Press during playback.
- The control box appears on LCD.
- If the control box does not appear on LCD, adjust the control box.

[Ez menu] kk  [Control Box] kk  [On]

Press to pause.

Press to resume playback.

Press / to play the previous or next 
file.

Press and hold / for two seconds during
playback and then release at a point you 
want.

Press or to control the volume.

Press to select a point A and a point B and 
repeats a sequence from point A (Starting point) 
to point B (End point). 
Press to exit.A-B

A-B

+-

: Pause / : Play

/ : Skip

/ : Search

/ : Volume control+-

: A-B section repeatA-B
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Playing movie
You can use the functions of MP3 player by touching the LCD.
MP3 player can only play the video files downloaded via LG Media
Center. For details about download, see the Help menu [Converting
video file] on LG Media Center.

OVER THE RAINBOW : Garden of Useful 
M i 2 P f U f l P bli hi SY00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful 
M i 2 P f U f l P bli hi SY00:0041 -00:02:23

Press twice the middle part of LCD during 
playback. 
Press twice the middle part of LCD again to 
resume playback.

Drag the middle part of LCD in the direction of 
the left/right  during playback. 

Drag the LCD during playback and then press 
and hold the LCD. And then release at a point 
you want.

Keep pressing and turn the point you press on 
LCD clockwise/counterclockwise during playback.

Play/Pause Skip/Search Volume control

26

: Pause, : Play

/ : Skip

/ : Search

Volume control

Note

- Select a file you want and press , you can delete it.
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Playing movie
You can use the functions of MP3 player by touching the control box on
LCD.

Press during playback.
- The control box appears on LCD.
- If the control box does not appear on LCD, adjust the control box.

[Ez menu] kk  [Control Box] kk  [On]

Press to pause.

Press to resume playback.

Press / to play the previous or next 
file.

Press and hold / button for two seconds 
during playback and then release at a point you 
want.

Press or to control the volume.+-

00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful Publ

+

-

: Pause / : Play

/ : Skip

/ : Search

/ : Volume control+-
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Viewing photo
You can use the functions of MP3 player by touching the LCD.

Press the middle part of LCD when a photo file is 
displayed.

Press the middle part of LCD again to pause.

Drag the middle part of LCD in the direction of 
the left/right  during playback.

When you listen to music or radio while viewing 
the photo file, control the volume. (FM radio 
reception is optional.)

Keep pressing and turn the point you press on 
LCD clockwise/counterclockwise during playback.

Play/Pause Skip Volume control

24

: Play

: Pause

/ : Skip

Volume control

Note

- Select a file you want and press , you can delete it.
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Viewing photo
You can use the functions of MP3 player by touching the control box on
LCD.

Press during playback.
- The control box appears on LCD.
- If the control box does not appear on LCD, adjust the control box.

[Ez menu] kk  [Control Box] kk  [On]

+

-

Press to set the slide show.

Press to pause.

Press / to view the previous or next photo.

When you listen to music or radio while viewing 
the photo file, control the volume. (FM radio 
reception is optional.)

Press or to control the volume.+-

/ : Volume control+-

: Slide show

: Pause

/ : Skip
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Listening to the FM radio (Option by models)
You can use the functions of MP3 player by touching the LCD.

Press the middle part of LCD while listening to 
the radio. 

Press the middle part of LCD again to listen to 
the radio.

Drag the middle part of LCD in the direction of 
the left/right while listening to the radio. 

Drag the middle part of LCD in the direction of 
the left/right during reception and then press and 
hold the LCD. And then release at a point you 
want.

Keep pressing and turn the point you press on 
LCD clockwise/counterclockwise while listening 
to the radio. 

Mute/Play Manual Search/
Automatic Search

Volume control

24

: Mute, : Play

/ :  Manual
Search

/ : Automatic
Search

Volume control
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Listening to the FM radio (Option by models)
You can use the functions of MP3 player by touching the control box on LCD.

Press during playback.
- The control box appears on LCD.
- If the control box does not appear on LCD, adjust the control box.

[Ez menu] kk  [Control Box] kk  [On]

+

- Mode
Mode Mode

Press to set muting.

Press to listen to the radio.

Select a mode you want to search by pressing 
repeatedly.

Press / to manually search the frequency.
The frequency decreases/increases step by 
step.

Press / to automatically search the 
frequency. The corresponding frequency will be 
automatically received.

Press / to search the stored channel.
The channel decreases/increases channel by 
channel.

Press or to control the volume.+-

Ch +Ch +Ch - Ch +Ch -

Mode Mode

Ch +Ch -Ch - Ch +Ch -

Mode Mode

Mode ModeMode Mode

ModeMode Mode

: Mute / : Play

: ModeModeMode Mode

/ : Manual Search
Mode ModeMode Mode

/ : Volume control+-

/ :  Automatic
SearchMode ModeMode Mode

/ :  The stored
channel
Search

Ch +Ch +Ch - Ch +Ch -

Mode Mode

Ch +Ch -Ch - Ch +Ch -

Mode Mode
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Viewing Text
You can use the functions of MP3 player by touching the LCD.

Press the middle part of LCD when a text file is 
displayed.

Press the middle part of LCD again to pause.

Drag the middle part of LCD in the direction of 
the left/right during playback.
Touch the left or right end of the screen.

Drag the LCD during playback and then press 
and hold the LCD. And then release at a point 
you want.

When you listen to music or radio while viewing 
the photo file, control the volume. (FM radio 
reception is optional.)

Keep pressing and turn the point you press on 
LCD clockwise/counterclockwise during playback.

Play/Pause Skip/Search Volume control

24

: Play

: Pause

/ : Skip

Search

Volume control

Note

- Select a file you want and press , you can delete it.
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Viewing Text
You can use the functions of MP3 player by touching the control box on
LCD.

Press during playback.
- The control box appears on LCD.
- If the control box does not appear on LCD, adjust the control box.

[Ez menu] kk  [Control Box] kk  [On]

+

-

Press to skip the page automatically.

Press to pause.

Press / to view the previous or next page.

Press and hold / button for two seconds 
during playback and then release at a point you 
want.

When you listen to music or radio while viewing 
the text file, control the volume. (FM radio 
reception is optional.)

Press or to control the volume.+-

/ : Volume control+-

Search

/ : Skip

: Play
: Pause



You can download from MP3 player
the files you want via LG Media
Center.
For details, see the Help menu on
LG Media Center.

1 Connect one end of the USB
cable to the USB port of the PC
and the other to the USB port of
MP3 player.
- Check whether both ends of the

cable are correctly plugged in.

2 Execute the LG Media Center
and then click [Add Library]. 

3 [Add file] k Selecting the down-
ing file (Ex: Music file) k [Apply]
k [Ok] k [Close]

4 [Music] k [Send to Device]
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LG Media Center
To download files - LG Media Center



5 Drag the files to the [Send to
Device]. 

Note

- is quick button to move files
at once.

To convert video files
1 Select a file to convert k [Tools]

k [Advanced Tools] k [Convert
Format]

- is quick button to convert
files at once.

2 Check the video file and then
select the Model, Name to add in
front converted file name, and
Output in [Convert Format] menu.

3 Click [Start]. 
- The video file is converted.

Note
- For details, see the Help menu

on LG Media Center.
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LG Media Center



To download files - MSC mode
1 Check whether the device is connected through the MSC mode.

- [Settings] of Home Menu  k [General] k [PC Connection Setting] k
Removable Disk (MSC)

2 Connect one end of the USB cable to the USB port of the PC and the
other to the USB port of MP3 player.
- Check whether both ends of the cable are correctly plugged in.

3 Check whether a new drive has been added in the Windows Explorer in
the PC.
- The drive name may differ depending on the OS.

4 Drag the file to copy to the removable disc drive.
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How to Download



Note
- Disconnecting the USB cable while the file is being copied may cause 

malfunction of MP3 player.
- MP3 player will be charged when connected to the PC through the USB cable.
- Use LG Media Center to convert video files and download to device.
- Download the JANUS DRM-applied files through the

Windows Media Player 10 or higher, or LG Media Center (MTP Mode only)
- Download X-Sync DRM-applied files through the LG Media Center.
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How to Download
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Error Code
Code Num Correction

CODE 0001~0008 From the <Download> menu on the Homepage,
download “FM37.ROM” and “FM37vis.pac”. 
Upgrade with newest version. 

CODE 0010 From the <Download> menu on the Homepage,
download to the config folder and upgrade the player
with the newest “FM37.INT”. Next do initialization.
[Setting]->[General]->[Initialize settings]

CODE 0013 Reset the player.

CODE 0015 It is an abnormal ROM file. Download and
upgrade the player with the newest ROM file.

CODE 1001, 3001 The data is damaged. Delete it.

CODE 1002, 9001 Connect the player to PC and format it. (Or activate
the format function on setting menu. [Settings -
General setting - Format]

CODE 2001 This is an abnormal movie file or a file that is not con-
verted on or supported by LG Media Center. Check
whether the file plays back on PC normally.

CODE 2002 Check whether the file plays back on PC normally.
If not,  convert and download it again on LG Media Center.

CODE 3003 The player does not support some JPEG Progressive files.
Download files again through LG Media Center.

CODE 9002, 9003 Connect the player to PC and delete the file/folder.

Refer to the pages 48~49 of the Owner’s manual for details.




